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一．软件安装 

Cary WinUV软件共有2张光盘：Cary WinUV、Cary WinUV Help & Videos

，请依照上述次序，按照电脑提示依次安装。 

1．将 Cary WinUV软件光盘放入光盘驱动器中，光盘将自动运行。

   选择“我同意”并单击“下一步”。

 

 

 

 

 

 

 

 

2. 浏览并选择安装文件夹，单击“下一步”。

 

 

 

 

 

 

 

 

 

 

 

 

3. 勾选需要安装的组件，单击“下一步”。  
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4．单击“安装”。

 

 

 

 

 

 

 

 

 

 

  

5．显示安装进程Ȃ 

 

 

 

 

 

 

 

 

 

 

 6. 最后，单击“完成”Ȃ
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pengfxia
Note
Accepted set by pengfxia

pengfxia
Note
Accepted set by pengfxia

pengfxia
Note
MigrationConfirmed set by pengfxia

pengfxia
Note
MigrationConfirmed set by pengfxia



 

 

7. 将 Cary WinUV软件光盘取出，将标注有 Cary WinUV Help & Videos CD的光盘,放入光驱，

等到跳出下面的安装页面，单击ľInstall HelpĿȂ

 

 

 

 

 

 

 

 

8.勾选所需要的安装组件̆ 单击ľOKĿȂ

 

 

 

 

 

 

 

 

 

 

 

 9. 选择默认安装路径̆单击ľYesĿȂ
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10．显示安装进程Ȃ
 
 
 
 
 
 
 
 
 
11. 当页面状态显示ľFinishedĿ，单击ľCloseĿ，安装结束Ȃ
 
 
 
 

12̈安装完后，电脑桌面将显示Cary WinUV快捷方式图标。   
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二．软件功能简介 

Cary WinUV软件分为：分析软件包 Cary WinUV Analysis Pack、生化软件包
Cary WinUV Bio Pack、制药软件包 Cary WinUV Pharma Pack三种。安装 Cary 
WinUV Bio Pack后，双击电脑桌面上的Cary WinUV快捷方式，将显示Cary WinUV
软件主窗口： 

 
 

一．  ADL Shell             应用发展语言解释程序 

二．  Advance Reads         高级读数定波长测定软件 

三．  Align                 仪器调整软件 

四．  Cary ADL Help         应用发展语言帮助信息 

五．  Cary Help             Cary软件邦助信息 

六．  Cary Tip of The Day   显示软件的一些操作技巧 

七．  Concentration         浓度测定软件 

八．  Enzyme Kinetics       酶动力学 

九．  GLP Administration    实验室管理及密码设定 

十．  Kinetics              动力学 

十一. RNA-DNA               核酸测试 

十二. Scan                  波长扫描软件 

十三. Scanning Kinetics     扫描动力学 

十四. Simple Reads          简单读数 
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十五. System Information    系统信息 

十六. Thermal               热分析 

十七. Troubleshoot Windows  故障寻找 

十八. Validate              仪器检定软件 

分析软件包没有 Enzyme Kinetics酶动力学和 RNA-DNA核酸测试功能模块，

制药软件包将生化软件包中的 GLP Administration 实验室管理及密码设定功能模

块换成 21CFR11 Assistant电子签名。 

 

 

三．软件帮助信息 

在 Cary WinUV软件中，具有关于仪器安全性、软件操作、附件、故障排除、
日常维护等方面详尽的说明，仪器使用者在使用过程中，对于软件、硬件有什么

疑问，都可以方便地使用帮助功能，寻找答案。 
在 Cary WinUV软件主窗口下双击 Cary Help图标，或者在软件操作界面上

的菜单栏里选择 Help→Help Topics，进入软件的帮助模块： 

 

利用目录浏览感兴趣的主题： 
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也可以利用主题词进行搜索，例如单击“搜索”，后在“输入要查找的单词”

中输入“Scan”，帮助文件中包含“Scan”这个单词的文件将依次显示出来，双击

其中的主题就可以显示具体内容： 

 

 

 

9



 

四．运行软件    

1. 打开电脑进入 Windows操作系统。 

2. 保证样品室内是空的。 

3. 双击电脑桌面上的 Cary WinUV图标。 

4. 在 WinUV主窗口下，双击所选图标（以 Concentration为例）。进入浓度主菜
单（详见后面浓度软件中文说明）。 

 

五．软件菜单说明 

以 Concentration为例（其他模块略有差异）： 

 

File  文件菜单 

 

New Method…        ：新建测试方法 

Open Method…       ：打开存储过的方法 

Open Report…       : 打开报告。  用该项打开以前所储存的报告 

Open Data…         ：打开数据 

Save Report As…    : 存储报告。  报告文件扩展名为 *.RSR. 
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Save Data As…      : 保存数据 

Print Setup         : 打印机设置(包括打印机选择、颜色、纸张设置等) 

Print Preview       : 打印预览 

Print               : 打印报告  

Explorer            : 探测项. 可用来进入 Windows 资源管理对话框, 在此 

                      可放置报告文件的位置. 

Exit                : 退出 Cary 应用软件。 

 

 
Edit  编辑菜单 

放在下面的选项仅当选择了 Edit Report 之后才有效。 

Undo        ：撤销上一步操作。 

Cut         : 用该项将选黑的文字剪切下来，并将其放在 Windows书写板上。 

Copy        : 用该项将选黑的文字拷贝到 Windows 书写板上。 

Paste       : 粘贴。恢复报告中剪切或删除的内容。或将 Windows书写板上 

              的内容粘贴到光标所在之处。 

Delete      : 在进行报告编辑时可删除所选的某项数据。 

Select All  : 将报告中所有内容选中。 

Font        ：设置字体。 

Edit Report : 报告编辑。选择该项后可对报告进行编辑。 
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View    查看菜单 

 

Toolbar         :  显示工具条。 

Buttons         :  选择该项显示功能按钮，不选择该项功能按钮隐藏。 

Graphics        ： 显示图表。 

Report          :  选择该项显示报告区，不选择报告区隐藏。 

Report Vertical :  垂直显示报告区。 

ADL             :  显示应用发展语言编辑窗。 

ADL Editor      :  ADL编辑器 

ADL Vertical    :  垂直显示应用发展语言编辑窗。 

ADL Hooks       :  连接应用发展语言。 

Quick Reference :  快速参考。该项可查 ADL语句。 

Hints           :  选择该项显示提示文字，不选择隐藏提示文字。 

Status Display  ： 显示仪器状态。 

12



 

 

Command 命令菜单 

Stop            : 停止测试 

Connect         : 软件联机 

Rapid Result    : 快速测试 

Zero            : 参比调零 

Reread          : 重新读数 

Goto            : 设置测试波长 

Align           : 仪器、附件校准 

Clear Report    : 清除报告按钮，可清除报告栏内容 

Recalculate     : 重新计算按钮，对采集数据重新计算、设置报告内容 

Lamps Off       : 关闭光源 

ADL Command     : 编写 ADL 

Return ADL      : 返回到 ADL编辑窗口 
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Graph（图形功能菜单） 

 图形功能可用两种方式进行。 

  1. 点图谱菜单或在某个谱图上点鼠标右键，弹出一个菜单，然后从菜单中选择

相应功能。 

  2. 用图形工具条；见下面说明          

        

 

 

 

   

 

 

Trace Prefereces  

选该项将某个谱图调出显示在图形框中并且可改变图线颜色。 

Graph Preferences 

选该项可设置谱图显示格式。该设置对所有谱图都起作用。 

Cursor Modes 

选该项定义光标模式，便于对谱图进行观察、跟踪、处理。可设置为自由

光标或跟踪光标。 

Axes Scales…（坐标轴刻度） 

用该项可设置坐标的标尺大小。 

Autoscale.[XY]  X,Y 轴同时自动标尺刻度。 

选该项可对 Y轴高度和 X轴宽度自动设置坐标标尺，并使谱图显示满图形

框。 

Autoscale[X]  X 轴方向宽度自动标尺刻度。 

选该项可对Ｘ轴自动刻度。 

Autoscale[Y]  Y 轴自动标尺刻度。 

选该项可对 Y轴自动刻度，根据收集数据值充满显示屏。 

Zoom Out  （局部放大） 

用该项可对局部图形放大到全屏幕显示。 

Add Label  （给谱图加标签） 

用该项可打开 Add Label对话框，可为谱图加文字标签。 

Add Picture  （加图片） 

用该项可打开 Add Picture对话框，可对谱图插入图片、如 bitmap图或

化学分子结构图等。 

Single/Multi Graphs （单个或多个谱图） 

选该项可显示单个或多个谱图。 

Auto Arrange Graphs （自动排列谱图） 

用该项可同时观看、排列所有谱图。 

Add Graph （加谱图） 

选该项可在图形显示区中增加一个谱图显示框。 

Remove Graph  （减谱图） 

选该项将某个谱图从图形显示框中去掉。 

Clear All Graphs  （清所有谱图） 
用该项可对图形显示区中所有谱图清除。 
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Help 帮助菜单 

Concentration Help : 浓度帮助信息，直接跳转到本主题 

Help Topics        : 帮助信息 

Tip of the Day     : 软件小技巧 

About              : 关于本软件 
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六．软件使用步骤 

1．新建一个测试方法： 

  1）单击 Setup功能键，进入参数设置页面。 

  2）按 Cary →Standards→Samples→Accessories1→Accessories2→Samplers

→Reports→Auto store顺序,设置好每页的参数。然后按 OK回到浓度主菜

单。 

  3）单击 View菜单，选择好需要显示的内容。 

      基本选项为 Toolber；buttons；Graphics；Report。 

  4）单击 Zero放空白到样品室内→按 OK。 

      提示：Load blank press ok to read（放空白按 ok读）。 

  5）单击 Start，出现 标准／样品 选择页。 

      Solutions Available（现有的溶液）。此左框中的标准或样品为不需要重

新测量的内容。 

      Selected for Analysis（选择需要分析的标准和样品）。此右框的内容为

准备分析的标准和样品。 

  6）按 OK进入分析测试。 

      Present std1（1.0g/l）Press OK to read.   

提示：放标准 1到样品光路，然后按ＯＫ键进行读数。 

      Present std2（2.0g/l）Press OK to read.       

放标准 2样品光路，按 OK进行读数。直到全部标准读完。 

  7）Present Sample1 press OK to read． 

      放样品 1到样品光路，按 OK开始读样品，直到样品测完。 

  8）为了保存标准曲线在方法中，可在测完标准后，不选择样品而由 File 文件

菜单中 Save Method As…保存此编好的方法。以后调用此方法 Open Method…时，
标准曲线一起调出。 

2．运行一个已存的方法（方法中包含标准曲线）。 

  1）单击 File→单击 Open Method…→选调用方法名→单击 Open． 

  2）单击 Start开始运行调用的方法。 

     如用己存的标准曲线，在右框中将全部标准移到左框。按 OK→进入样品测试。 

  3）按提示完成全部样品的测试。 

  4）按 Print键打印报告和标准曲线。 

  5）如要存数据和结果，单击 File文件。 

      选 Save Data As…．在下面 File name中送入数据文件名，如果在 File of 

Type中选择“Spreadsheet Ascii(*.csv)”可以将测试结果保存为 Excel格式，

在其他装有 Microsoft Office的电脑上打开，单击 Save。全部操作完成。 

       

其它软件包如 Scan软件操作步骤相同，具体内容有些差别，请按屏幕提示操作。  
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七．软件功能模块 

7．1 简单读数 (Simple Reads) 

在 Cary WinUV主窗口中用鼠标双击 Simple Reads图标，进入简单读数控制

程序页面。 

该软件可对样品进行定波长简单吸光度测量, 并可用’User Collect’ 选项对
多个波长测量点进行简单的计算。 

 
 
菜单 

File         : 文件菜单 

Edit         : 编辑菜单 

View         : 观察菜单 

Commands      : 命令菜单 

Setup         : 设置菜单 

Help         : 帮助菜单 

按钮 

Read         : 开始读数按钮 
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Zero          : 测空白回零按钮 

Setup         : 参数设置按钮 

Clear report  : 清除报告按钮，可清除报告栏内容 

Print         : 打印报告按钮，打印报告拦内容 

1. 单击 Setup 按钮进入仪器条件和参数设置页：  

 
Cary 仪器控制页面 

 

Read Mode  读数方式 

Read at Wavelength : 选择测量波长 

User Collect       : 用户定义, 用户可以自己设定几个波长进行数学运算 

               举例: 计算 260/280nm比值并在 320nm处进行扣背景， 

在右手长框中输入计算公式:(Read(260)-Read(320))/(Read(280)-Read(320))。 

Instrument  仪器 

Ave Time(Sec)      ：平均时间，即仪器的采样时间，平均时间越长，采集的数

据越多, 平均值显示比较稳定, 在定波长测定中一般选择 1 

秒平均时间为合适。 

SBW(nm)           ： 光谱带宽，带宽越大，通过单色器狭缝的能量越高，但是

光的单色性越差。一般选择默认值 1.5nm就可以。 

Y Mode     Y轴方式 

  Abs              : 吸光度单位 

  %T               : 透过率单位 

Abs*F              : 吸光度乘以某个设定系数. 系数值由用户设置 

% R                : 反射率 
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按 OK 设置完成。 

2. 放入空白样品，按 Zero  按钮，测空白回零 

   放入待测样品在样品光路中，按 Read  按钮，开始读数 

3．测试完毕，单击“File” →“Save Data As…”保存实验结果。 

7．2高级读数(Advanced Reads) 

在 Cary Win UV 主窗口中用鼠标双击 Advanced Reads 图标，进入高级读数

控制程序页面。 

该软件对样品在各种条件下进行定波长吸光度测量, 并可用’User Collect’ 
选项对多个波长测量点进行简单的计算。 

 

 

菜单 

File         : 文件菜单 

Edit         : 编辑菜单 

View         : 观察菜单 

Commands      : 命令菜单 

Setup         : 设置菜单 

Help         : 帮助菜单 
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按钮 

Start         : 开始读数按钮         Stop      : 停止读数按钮 

Setup         : 参数设置按钮 

Zero          : 测空白回零按钮 

Reread        : 重新读数按钮,可对已读数样品进行重新读数 

Clear report  : 清除报告按钮，可清除报告栏内容 

Recalculate   : 重新计算按钮，对采集数据重新计算、设置报告内容 

Print         : 打印报告按钮，打印报告拦内容 

 

1．单击 Setup 按钮进入仪器条件和参数设置页： 

 

Cary 仪器控制页面 

Instrument   仪器参数 

Wavelength(nm）    : 选择测量波长 

User Collect       : 用户定义。 用户可以自己设定几个波长进行数学运算 

               举例: 计算 260/280nm比值并在 320nm处进行扣背景在右手长 

                     框中输入计算公式: 

                     (Read(260)-Read(320))/(Read(280)-Read(320)) 

Ave Time(Sec)      ：平均时间，即仪器的采样时间，平均时间越长，采集的数

据越多, 平均值显示比较稳定, 在定波长测定中一般选择 1 

秒平均时间为合适。 

SBW(nm)           ： 光谱带宽，带宽越大，通过单色器狭缝的能量越高，但是
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光的单色性越差。一般选择默认值 1.5nm就可以。 

Replicates         : 重复读数次数。多次读数，取平均值。 

Sample Averaging   : 样品等分数。可将样品分成数个等分，分别测量，得到 

                     平均结果。 

Y Mode     Y轴方式. 

  ABS              : 吸光度单位 

  %T               : 透过率单位 

Abs*F              : 吸光度乘以某个设定系数. 系数值由用户设置 

% R                : 反射率 

 

单击“Samples”进入样品设置页面： 

 

Samples   样品名设置 

 

Sample Names  样品名 

Number of Samples   :所测样品数量 

Samples Names       :样品清单。每个样品名称有 20个字符 

Increment           :样品名称复制按钮 

Import Names        :ASCII码样品名称文件输入 

 

单击“Options”进入选项设置页面： 
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Options   选项页面 

  Collection Options : 收集选择 

  Source             : 灯源选择 

  Auto Lamps off     : 自动灯源关闭：该项选择表示一个方法程序运行完后 

                       灯自动关闭。 

  UV                 : 选择紫外灯源打开。 

  Vis                : 选择可见灯源打开。 

  UV-Vis             : 仪器将同时打开紫外及可见灯。 

  Third              ：选择打开波长校正用的汞灯。 

  Source Changeover( nm）: 设定光源切换波长。 

Detector Changeover( nm）: 设定检测器切换波长。 

   

Beam Mode        :  光束方式选择 

  Single Beam      :  单光束方式。选择此项仪器按单光束方式测量。 

  Double Beam      :  双光束方式。选择此项仪器按双光束方式测量。 

  Normal           :  正常模式。选择此方式，表示靠近仪器前面板为样品光

束，另一个为参比光束。 

  Reverse          :  反相模式。选择此方式，表示靠近仪器前面板为参比光

束，另一个为样品光束。 

  Energy           :  能量水平决定检测器对参比光束光线的放大能力。在双

光束方式下，能量水平由参比光束光线的强弱所决定，

不用设定。而在单光束方式，则需手动设定。 

 

单击“Reports”进入打印报告设置页面： 
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Reports  设置报告参数 

 

Operator   操作者 

Name            ：操作者名字 

Comment         ：注释 

Option     报告所包含的内容 

AutoPrint       : 在数据采集过程中自动打印数据 

Parameters      ：仪器参数包含在报告中 

Results         ：测试结果包含在报告中 

Company Logo    ：在报告中包含公司商标 

Autoconvert 自动转换 

Select for ASCII(CSV): 选择转换为 ASCII码 

单击“Auto Store”进入保存设置页面： 

 

Auto Store 自动保存设置 
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Storage 保存 

Storage off                :自动保存关闭 

Storage on(Prompt at start):在开始实验时软件提示保存实验数据 

Storage on(Prompt at end)  :在结束实验时软件提示保存实验数据 

 

按 OK 设置完成。 

2．放入空白样品，按 Zero  按钮，测空白回零 

按 Start 按钮，根据屏幕提示，输入文件名，依次将样品放入样品光路进行

样品测试。 

 按 Stop 按钮,停止样品测试。 

3．测试完毕，单击“File” →“Save Data As…”保存实验结果。 
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7．3 浓度测定 (Concentration) 

该软件包用来测量样品浓度。先配置一系列不同浓度的标准样品，依次测试

其吸光度，建立标准工作曲线，再测试未知浓度的样品，软件自动计算出其浓度。    

在 Cary Win UV 主窗口中用鼠标双击 Concentration图标，进入浓度测量控

制程序页面。 

 

菜单 

File         : 文件菜单 

Edit         : 编辑菜单 

View         : 观察菜单 

Commands      : 命令菜单 

Setup         : 设置菜单 

Graph         : 图形菜单( 图形工具条代表图形菜单中功能, 使用直观方便) 

Help          : 帮助菜单 

 

按钮 

Start         : 开始读数按钮         Stop      : 停止读数按钮 

Setup         : 参数设置按钮 
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Zero          : 测空白回零按钮 

Reread        : 重新读数按钮,可对已读标准或样品进行重新读数 

Clear report  : 清除报告按钮，可清除报告栏内容 

Recalculate   : 重新计算按钮，对采集数据重新计算、设置报告内容 

Print         : 打印报告按钮，打印报告拦内容 

1.单击 Setup 按钮进入仪器条件和参数设置页。 

 

Cary 仪器控制页面 

 

Instrument  仪器参数 

Wavelength(nm）    : 选择测量波长 

User Collect       : 用户定义。 用户可以自己设定几个波长进行数学运算. 

               举例: 计算 260/280nm比值并在 320nm处进行扣背景在右手长 

                     框中输入计算公式: 

                     (Read(260)-Read(320))/(Read(280)-Read(320)) 

Ave Time(Sec)      ：平均时间，即仪器的采样时间，平均时间越长，采集的数

据越多, 平均值显示比较稳定, 在定波长测定中一般选择 1 

秒平均时间为合适。 

SBW(nm)           ： 光谱带宽，带宽越大，通过单色器狭缝的能量越高，但是

光的单色性越差。一般选择默认值 1.5nm就可以。 

Replicates        : 重复读数次数。多次测量，取平均值。 

Sample/Std Averaging: 样品等分数。可将标准样品分成数个等分，分别测量 

                      得到平均结果，以减少人为误差。 

Y-mode            :  定义 Y坐标模式. 可为吸光度和发射(用于荧光测量)两种
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方式。 

          ABS (吸光度)            Emission (发射强度) 

Y min              : 显示的最小吸光度值 

Y max              : 显示的最大吸光度值 

Show Status Display:  显示仪器状态, 包括曲线校正, 当前样品名称及浓度。 

 

上面各项参数选择完后单击 Standards 后进入标准设置页面： 

 

Standards  标准样品栏设置页面 

 

Standards Setup （标准设置） 

Standards  （标准） 

Calibrate during run: 运行期间校正。选该项后，仪器在进行样品测试前， 

                      提示先进行标样测试。 

Units (单位）      :  在该项中可输入标样的单位，如 mg/ml , g/l 等也 

                      可由右手的箭头中选合适的单位。 

Standards(标准）   :  该框选标样数。 

Standards          :  标样表。在该表中输入标样浓度。 

表格内容说明： 

Std ：显示标样号；  Conc ：输入标样浓度；   

Fit Type           :  选择标准曲线类型。有三种方式： 

Linear             :  线牲不过原点。 

Linear Direct      :  线性过原点。 

Quadratic          :  二次曲线。 

Min R2             :  相关系数。该系数可设定，如果标准曲线达不到设定 

                      值，则会出现提示，以吸光度方式继续测量样品或停 

                      止测量。0.95为默认值。 

 

单击 Samples进入下面一页样品设定页： 
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Samples    样品设置页面 

 

Sample Names      : 样品名称  

Number of Samples : 样品数。右框中上下剪头确定分析样品的数量。 

Sample Names      : 样品名称清单。在该项输入样品名称及编号。 

Actual Weight     : 在该项可输入样品的实际秤样量，以便进行重量校正。 

Actual Volume     : 在该项可输入样品的实际稀释体积，以便进行体积校正。 

Increment         : 增量。用该钮自动复制样品名称，名称最后按数字自动 

                    增加编号。 

Import Name       : 用该项可将 ASCII码形式的样品名称文件输入进来。 

Weight/Volume Corrections  (重量/体积校正） 

Method Weight     : 标称重量。该项输入该分析方法所用秤样量。 

Units             : 输入重量单位。 

Method Volume     : 定容体积。该项输入该分析方法所用样品体积。 

Units             : 输入体积单位。 

校正公式 

重量校正         :  测量结果*Method Weight/Actual Weight 

体积校正         :  测量结果*Method Volume/Actual Volume 

如果对重量校正、体积校正不熟悉，也可以不勾选 “□ Corrections校正”项。 
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单击“Options”进入选项设置页面： 

 

Options   选项页面 

  Collection Options : 收集选择 

  Source             : 灯源选择 

  Auto Lamps off     : 自动灯源关闭：该项选择表示一个方法程序运行完后 

                       灯自动关闭。 

  UV                 : 选择紫外灯源打开。 

  Vis                : 选择可见灯源打开。 

  UV-Vis             : 仪器将同时打开紫外及可见灯。 

  Third              ：选择打开波长校正用的汞灯。 

  Source Changeover( nm）: 设定光源切换波长。 

Detector Changeover( nm）: 设定检测器切换波长。 
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  Beam Mode        :  光束方式选择 

  Single Beam      :  单光束方式。选择此项仪器按单光束方式测量。 

  Double Beam      :  双光束方式。选择此项仪器按双光束方式测量。 

  Normal           :  正常模式。选择此方式，表示靠近仪器前面板为样品光

束，另一个为参比光束。 

  Reverse          :  反相模式。选择此方式，表示靠近仪器前面板为参比光

束，另一个为样品光束。 

  Energy           :  能量水平决定检测器对参比光束光线的放大能力。在双

光束方式下，能量水平由参比光束光线的强弱所决定，不用设定。而在单光束方

式，则需手动设定。 

单击 Reports 进入报告参数设置页面，选择打印报告中包含的内容和打印格式： 

 

                         Reports  报告参数设置页面 

 

Reports Entry and Selections  （报告入口和选项） 

Operator  （操作者） 

Name         : 名字。在此可输入操作人员姓名。   

Comment      : 注释。在该项下可输入一段文字注释。 

Options      : 选项。在选项下面选择报告所要包含的内容。 

AutoPrint    : 选此项可在数据采集过程中自动打印报告。 

Parameters   : 参数。选此项可将仪器参数包含在打印报告中。 

Results      : 结果。选此项可在报告中包含测量数据的结果。 

Company Logo : 公司商标。选该项可在报告中包含所设公司商标。该商标可用 

               Windows的绘图软件完成（bitmap 文件）并在 Cary系统信息 

               页面中设置。 

Graph        : 图表。选该项可在报告中包含标准曲线。 

%Page Height : 用该项设置图形占整个页面的百分比。 
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AutoConvert  : 自动转换。 

None         : 选该项不进行转换。 

Select for ASCII:  选该项将数据转换成 ASCII码文件（*.CSV）。 

Select for ASCII With Log :  选该项除将数据转换成 ASCII码之外，仪器方 

               法参数也被转换成 ASCII码。 

单击 Reports右边的小箭头，后单击 Auto Store（自动存储页）菜单转到下一页： 

 
Auto Store   自动存储页面 

 

File Storage   文件存储页 

Storage off                 :  选此项表示测量结果不自动储存。 

Storage on (prompt at start): 选此项表示自动存储数据并在开始进行数 

                              据采集前提示输入数据文件名称。 

Storage on (prompt at End)  :  选此项表示自动存储数据并在完成数据采集 

                              后提示输入数据文件名称。 

 

全部设置完成后按 OK 退回到浓度主菜单。 

2.放入空白样品，按 Zero  按钮，测空白回零 

按 Start 按钮，根据屏幕提示，输入文件名，依次将样品放入样品光路进行

标准品测试、样品测试。 

 按 Stop 按钮,停止样品测试。 

3．测试完毕，单击“File” →“Save Data As…”保存实验结果。 
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7．4 波长扫描（Scan） 

该软件包用于波长扫描来测量样品，并对结果进行运算。 

1．在 Cary Win UV 主窗口中用鼠标双击 Scan图标，进入扫描测量控制程序页面。 

 

菜单 

File         : 文件菜单    

Edit         : 编辑菜单 

View         : 观察菜单 

Commands      : 命令菜单 

Setup         : 设置菜单 

Graph         : 图形菜单( 图形工具条代表图形菜单中功能, 使用直观方便) 

Maths         : 图谱计算器窗 

Help          : 帮助菜单 

 

按钮 

Start         : 开始扫描按钮         Stop      : 停止扫描按钮 

Setup         : 参数设置按钮 

Zero          : 测空白回零按钮 

Baseline      : 基线校正按钮,可进行不同类型的基线校正 
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Clear report  : 清除报告按钮，可清除报告栏内容 

Recalculate   : 重新计算按钮，对采集数据重新计算、设置报告内容 

Print         : 打印报告按钮，打印报告栏内容 

2.单击 Setup 按钮进入仪器条件和参数设置页 

 

Cary  仪器控制页面 

 

X Mode  X轴参数设置 

Mode （模式） ：     Nanometers    波长单位 nm 

                     Wavenumber    波数单位 cm
-1
 

                     Angstroms     埃 

Start （开始波长）nm               Stop  （终止波长）nm 

Y Mode  Y轴参数设置 

Mode  （模式） ：   Abs   （吸光度）            Log（Abs） 

                    %T    （透过率）            F （R） 

                    %R    （反射率）            Log （F（R）） 

                    Absolute （绝对反射率）     Log  （1／R） 

                    Absorptivity  （吸收率） 

Factor  （系数） 

Y min   （Ｙ轴最小读数）       Y max   （Ｙ轴最大读数） 

Cycle Count  （重复扫描次数）   Cycle  Time  （每个周期的时间间隔） 

Temperature Monitor  （温度显示）在 Accessories1设温度控制器后有效。 
 
Scan Controls  （扫描控制拦） 
Ave time（s）  （信号平均时间）最小时间间隔为 0.033S 
Data Interval（nm）（数据采集间隔）最小为 0.02nm 
Scan rate（nm／min）（扫描速度）  三者之间关系为设置二项参数后第三项自动
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设置。扫描速度越慢、数据间隔越小，仪器精度越高，但是测试时间将延长。 
 
单击 Options进入下面一页选项设定页： 

 

Options   选择页面 

 

Advanced  settings :  高级设置 

SBW/Energy         :  狭缝/能量参数的设置 

SBW(nm)            :  狭缝宽度，狭缝越小，分辨率越高，但是能量要低，所

以信噪比可能会变差。     

Beam  mode         :  光束选择模式 

Single  front      :  单光束样品在前面（靠近仪器面板） 

Single  rear       :  单光束样品在后面 

Double             :  双光束正常样品在前面 

Double  reverse    :  双光束反，样品在后面 

Energy             :  能量，单光束时有效。范围 0—255 

Slit height        ： 狭缝高度，Full:完全打开，此时仪器能量高，信噪比好。

Reduced:降低的，此时狭缝部分打开，用于测

试比较小的样品或者仪器连接某些附件时使

用。 

Source             :  光源选择 

Auto  lamps  off   :  选择该项表示程序运行完后自动关闭二个灯。 

选择 UV            ： 表示只开 D2灯。    选择 VIS：  表示只开钨灯。 

选择 UV-VIS        ： 表示二个灯同时开。 

选择 Third         ： 打开仪器校准用的汞灯。 

Source changeover(nm): 设置光源切换波长，内部设定值为 350nm。 

Detector changeover(nm)：设置检测器切换波长，内部设定值为 800nm。 

Grating changeover(nm) ：设置光栅切换波长，内部设定值为 800nm。 

Single-to-Noise mode  :  信噪比模式选择 

Acceptable  S/N       :  设置合理的信噪比值。内部设定值为 10000。 

S/N timeout (S)       :  设置信噪比限定时间。 
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                         如果在信噪比限定时间内无法达到所规定的信噪比，

仪器将继续进行下个数据的采集，同时给出错误信

息。 

Display  Options      :  显示图谱选项。 

Individual  Date      : 选择该项使所采集谱图分开显示。例如，有五个样品， 

                        当结束样品扫描测定后，每个样品单独占据一个图形

显示框。 

Overlay  Data         : （数据重叠），选该项使所有样品谱图在同一个图中重

叠显示。 

Show Status Display    : （状态显示）选该项在屏幕上将出现一个状态显示框。 

 

单击 Independent进入下面一页选项设定页: 

 

                       Independent 独立控制设定 

将紫外可见部分和近红外部分的数据采集间隔和带宽等参数独立设定，各参数的

意义同“Cary  仪器控制页面”和“Options   选择页面”中的介绍，一般不用

选择 Independent Control。 

 

单击 Baseline进入下面一页基线校正设定页。 
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Baseline Selection 基线校正设置页面 

 

Baseline Selection    :  基线类型选择 

Correction            :  校正选择框 

None                  :  选择该项表示不需基线校正 

Bseline  correct      :  选择该项时需要用参比样品进行 100％T基线校正 

Zero/baseline Correction : 选择该项时需要用参比样品进行 100％T 基线校正

和用挡光黑色物体进行 0%T 基线校正。当所测样品

的透过率很低时，需用该功能消除仪器噪声影响。 

Zero  SRA  correction    : 选择该项对镜面反射附件进行 100%T和 0%T基线校

正。 

Zero * std  ref  correction: 选择该项对积分球及可变角镜面反射附件进行

100%T和 0%T基线校正。 

Known  mirror        :  当用 VW 镜面反射附件（SRA）测量小样品或低反射样

品时选该框。  

Retrieve  Baseline  File : 重新调出基线校正文件。 

View  Baseline  File     :  查看基线校正文件. 

Retrieve  Std  Ref  File : 重新调用储存的参照物文件。用于 Zero std*Ref

校正。此项必须在选择 Zero std*Ref correction

后才有效。 

View std  Ref  File     :  显示参照物谱图。 
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单击 Reports 进入报告参数设置页面： 

 

Reports  报告参数设置页面 

 

Reports Entry and Selections  （报告入口和选项） 

Operator  （操作者） 

Name         : 名字。在此可输入操作人员姓名。   

Comment      : 注释。在该项下可输入一段文字注释。 

Options    (选项栏)  在选项下面选择报告所要包含的内容。 

AutoPrint    : 选此项可在数据采集过程中自动打印报告。 

Company Logo : 公司商标。选该项可在报告中包含所设公司商标。该商标可用 

               Windows的绘图软件完成（bitmap 文件）并在 Cary系统信息 

               页面中设置。 

User Data Form : 数据表 

Graph        : 图表。选该项可在报告中包含扫描图谱。 

%Page Height : 用该项设置图形占整个页面的百分比。 

Parameters   : 参数。选此项可将仪器参数包含在打印报告中。 

Results      : 结果。选此项可在报告中包含测量数据的结果。 

Peaks Table  ：峰位表 

All Peaks    : 选该项报告中显示所有峰的位置和峰值。 

Maximum Peak : 选该项可在报告中显示最大峰的位置和峰值。 

点击“Peak Information”进入峰信息设置页面： 

Peak Information: （峰信息）选该项可在图谱上标签峰的位置和大小。设置 

                            峰的域值。 
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Peak Type（峰类型）Peaks        ：在报告中只打印峰值。 

                   Valleys      ：在报告中只打印峰谷值。 

                   Peaks Valleys：在报告中打印全部峰和谷。 

                   Zero  Cross  ：过原点。该项为峰和谷的计算确定位置。 

Peak threshold（峰的域值）：为计算峰、谷设置一个限值。大于这个限值的 

                           峰和谷，在报告中反映出来。小于这个限值的峰， 

                           谷不在报告中打印。 

lable Type 标峰格式 

X and Y labels  ：选该项在谱图上标注峰的 X，Y值。 

Y label         ：选该项在谱图峰上只标 Y值。 

X label         ：选该项在谱图峰上只标 X值。  

No labes        ：不标。 

单击“OK”返回上级设置页面。 

X-Y  Pairs Table (X-Y值对应表)。选该项在报告中打印 X，Y表格。 

Use  Actual  Interval:    选该项表示 X，Y的间隔固定不变。 

Use  Interpolation  Interval :  选择该项可设置 X、Y对的间隔值。 

   

AutoConvert  （ 自动转换） 

None         : 选该项不进行转换。 

Select for ASCII:  选该项将数据转换成 ASCII码文件（*.CSV）。 

Select for ASCII With Log :  选该项除将数据转换成 ASCII码之外，仪器方 

               法参数也被转换成 ASCII码。 

 

单击 Auto Store（自动存储）菜单转到下一页。 
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Auto Store   自动存储页面 

File Storage   （文件存储页） 

Storage off                 :  选此项表示测量结果不自动储存。 

Storage on (prompt at start): 选此项表示自动存储数据并在开始进行数 

                              据采集前提示输入数据文件名称。 

Storage on (prompt at End)  :  选此项表示自动存储数据并在完成数据采集 

                              后提示输入数据文件名称。 

 

全部设置完成后按 OK 退回到扫描主菜单。 

3. 如需做基线校正，放入空白样品，按 Baseline  按钮，进行基线校正测试。 

按 Start 按钮，根据屏幕提示，输入文件名，依次将样品放入样品光路进行

样品扫描测试。 

 按 Stop 按钮,停止样品测试。 

4．如果需要对扫描结果进行吸光度 A－透过率 T 转换、求导等计算，单击菜单

“Math”。 

 

 

Math 计算菜单 
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Operation 操作 

可以进行光谱平均、归一、平滑、求导、积分、A值转换成 T％等等数学计算。 

1）单击“Selected Trace”选择需要变换的线条； 

2）单击“Operation”的下拉菜单选择需要变化的方式； 

3）单击“Apply”； 

4）点击“＝”就可以得到结果。 

 

5．测试完毕，单击“File” →“Save Data As…”保存实验结果。 

 

 

7．5 动力学测试（Kinetics） 

该软件包用于测试吸光度（透过率）在单波长或者多波长下随时间的变化情况。 

1．在 Cary Win UV 主窗口中用鼠标双击 Kinetics图标，进入动力学测试页面。 

 

 

菜单 

File         : 文件菜单    

Edit         : 编辑菜单 

View         : 观察菜单 

Commands      : 命令菜单 

Setup         : 设置菜单 

Graph         : 图形菜单( 图形工具条代表图形菜单中功能, 使用直观方便) 

Help          : 帮助菜单 
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按钮 

Start         : 开始扫描按钮（脱机时显示 Connect）    

Stop          : 停止扫描按钮 

Setup         : 参数设置按钮 

Zero          : 测空白回零按钮 

Baseline      : 基线校正按钮,可进行不同类型的基线校正 

Clear report  : 清除报告按钮，可清除报告栏内容 

Recalculate   : 重新计算按钮，对采集数据重新计算、设置报告内容 

Print         : 打印报告按钮，打印报告栏内容 

2．单击 Setup 按钮进入仪器条件和参数设置页： 

 

Cary  仪器控制页面 

Instrument  仪器 

Wavelength   : 测试波长 

User Collect : 用户定义, 用户可以自己设定几个波长进行数学运算 

               举例: 计算 260/280nm比值并在 320nm处进行扣背景， 

在右手长框中输入计算公式:(Read(260)-Read(320))/(Read(280)-Read(320))。 

SBW(nm)           ： 光谱带宽，带宽越大，通过单色器狭缝的能量越高，但是

光的单色性越差。一般选择默认值 1.0nm就可以。 

Ave Time(Sec)      ：平均时间，即仪器的采样时间，动力学测试时此参数设定

得小些在特定的时间段内采集到更多的数据。 
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X Mode         : X轴模式，Min 分钟， Sec 秒。 

Y Min/Y Max    : Y轴最小/最大显示值。 

Collect Timing : 采集计数 

Simple Collect : 单次采集 

Advance Collect: 分段采集               

Number of Stages: 分段数目 

Cycle(min)      : 循环时间 

Stop(min)       : 停止采集时间 

单击 Options进入下面一页选项设定页： 

 
Options 选项设置页面 

 

Collection Options :  采集选项 

Source             ： 光源 

Auto  lamps  off   :  选择该项表示程序运行完后自动关闭二个灯。 

选择 UV            ： 表示只开 D2灯。    选择 VIS：  表示只开钨灯。 

选择 UV-VIS        ： 表示二个灯同时开。 

选择 Third         ： 打开仪器校准用的汞灯。 

Source changeover(nm): 设置光源切换波长，内部设定值为 350nm。 

Detector changeover(nm)：设置检测器切换波长，内部设定值为 800nm。 

Grating changeover(nm) ：设置光栅切换波长，内部设定值为 800nm。 

Slit height        ： 狭缝高度， 

Full:完全打开，此时仪器能量高，信噪比好。 

Reduced:降低的，此时狭缝部分打开，用于测试比较小的

样品或者仪器连接某些附件时使用。 

Display  Options      :  显示图谱选项。 

Individual  Date      : 选择该项使所采集谱图分开显示。例如，有五个样品， 

                        当结束样品扫描测定后，每个样品单独占据一个图形
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显示框。 

Overlay  Data         : （数据重叠），选该项使所有样品谱图在同一个图中重

叠显示。 

Show Status Display    : （状态显示）选该项在屏幕上将出现一个状态显示框。 

 

单击 Analyze 进入结果分析设置页面： 

 

Analyze  结果分析设置页面 

 

Analysis  （报告入口和选项） 

Auto Calculate  : 自动计算  

Simple Calculate   : 简单计算 

Advanced Calculate : 高级计算 

Stage              : 分段数目 

Start(min)         ：开始时间 

Stop(min)          ：结束时间 

Order              ：反应级数设置（0级、1级或者 2级） 

 

单击 Samples（样品）菜单转到下一页： 
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Samples 样品设置页面 

Sample List      : 样品清单  

Number of Samples : 样品数。右框中上下剪头确定分析样品的数量。 

Sample Names      : 样品名称清单。在该项输入样品名称及编号。 

Increment         : 增量。用该钮自动复制样品名称，名称最后按数字自动 

                    增加编号。 

Import Name       : 用该项可将 ASCII码形式的样品名称文件输入进来。 

单击 Reports 进入报告参数设置页面，选择打印报告中包含的内容和打印格式： 

 

 
Reports  报告参数设置页面 

 

Reports Entry and Selections  （报告入口和选项） 

Operator  （操作者） 

Name         : 名字。在此可输入操作人员姓名。   
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Comment      : 注释。在该项下可输入一段文字注释。 

Options      : 选项。在选项下面选择报告所要包含的内容。 

AutoPrint    : 选此项可在数据采集过程中自动打印报告。 

Parameters   : 参数。选此项可将仪器参数包含在打印报告中。 

Results      : 结果。选此项可在报告中包含测量数据的结果。 

Company Logo : 公司商标。选该项可在报告中包含所设公司商标。该商标可用 

               Windows的绘图软件完成（bitmap 文件）并在 Cary系统信息 

               页面中设置。 

Graph        : 图表。选该项可在报告中包含标准曲线。 

User Data Form : 数据表。 

X-Y  Pairs Table (X-Y值对应表)。选该项在报告中打印 X，Y表格。 

AutoConvert  : 自动转换。 

None         : 选该项不进行转换。 

Select for ASCII:  选该项将数据转换成 ASCII码文件（*.CSV）。 

Select for ASCII With Log :  选该项除将数据转换成 ASCII码之外，仪器方 

               法参数也被转换成 ASCII码。 

单击 Auto Store（自动存储页）菜单转到下一页： 

 

Auto Store   自动存储页面 

 

File Storage   文件存储页 

Storage off                 :  选此项表示测量结果不自动储存。 

Storage on (prompt at start): 选此项表示自动存储数据并在开始进行数 

                              据采集前提示输入数据文件名称。 

Storage on (prompt at End)  :  选此项表示自动存储数据并在完成数据采集 

                              后提示输入数据文件名称。 

 

全部设置完成后按 OK 退回到浓度主菜单。 

3. 放入空白样品，按 Zero  按钮，测空白回零； 
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放入样品，按 Start 按钮，软件开始 2 分钟倒计时（可以跳过该步骤），后采集

数据，到达设定的终止时间后自动停止测试。  

 

4．测试完毕，单击“File” →“Save Data As…”保存实验结果。 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

46



 

7．6 仪器检定  （Validate） 

该软件可对仪器进行自测或用标准样品检定。 
1．在 Cary Win UV 主窗口中用鼠标双击 Validate 图标，进入仪器检定控制程序  

页面。 
2．单击“Test”按钮。 

 
3．在以下窗选 Instrument Performance Test。 
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双击Wavelength Accuracy-D2后进入波长准确度验证界面： 

 
 

此功能为根据氘灯的特征谱线验证仪器波长准确度。 
UV/VIS Tolerance(nm)：设定紫外可见区波长允许的偏差值，仪器默认值为±

0.1nm。 
NIR Tolerance(nm)：设定近红外区波长允许的偏差值，仪器默认值为±0.4nm。 
 
 

Wavelength Reproducibility：验证波长重复性。 

 
UV/VIS Tolerance(nm)：设定紫外可见区的波长重复性允许的偏差值。 
UV/VIS Standard Tolerance(nm)：设定紫外可见区的波长重复性允许的标准偏 
差值。 
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NIR Tolerance(nm)：设定近红外区的波长重复性允许的偏差值。 
NIR Standard Tolerance(nm)：设定近红外区的波长重复性允许的标准偏差值。 
 

Resolution：验证分辨率。 

 
Maximum HPBW：设定允许的最大半高宽。 
 

Baseline：验证基线平直度。 
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Noise：验证仪器噪声。 

 
 
UV/VIS Wavelength：设定紫外可见区测试噪声时的波长值。 
UV/VIS SBW：设定紫外可见区测试噪声时的带宽值。 
NIR Wavelength：设定近红外区测试噪声时的波长值。 
NIR SBW：设定近红外区测试噪声时的带宽值。 
Tolerance：设定允许的噪声值。 
 
4． 设定好上述参数后，单击“OK”。 
 
5． 在 Validate窗选 START按钮，进行仪器各项指标自测，全部自测 PASS后，
仪器可正常使用。 

 

说明：客户也可以准备氧化钬溶液、KNO3、K2Cr2O7、NaI溶液、NIST滤光片、甲苯

溶液等验证波长准确度、透过率准确度、杂散光和分辨率等指标。 

 

 

 

 

 

 

 

 

 

 

 

 

 

50



 

7．7 仪器调整（Align） 

在该软件下，可对可见灯和紫外灯进行调整。 

 
                         Align   灯调整菜单 
 
在WinUV主菜单中双击 Align进入这一页。 
Lamps            ：灯条件设置页。 
Source            ：光源 
UV：紫外灯（D2灯）。    VIS：可见灯（钨灯）。 Third：第 3个灯（汞灯）。 
VIS Source Hours：VIS灯工作小时显示。  
New  Source      ：新光源。单击一次此键为新灯开始，所以应在更换新灯时按

此键。 
Current Signal      ：当前信号棒显示。 
Rescale           ： 重新刻度（按此键改变检测器增益,并使刻度回到 100，在

调整时用）。 
Save  Conditions：   （存储条件），将当前选择的条件和数据存起来作为参考和

比较。 
Saved UV Source Conditions：    （存储 UV和 VIS源的条件）。      
Signal           ：信号                   Ave.Time    ： 信号平均时间。 
Energy          ：能量                    Wavelength ：波长 
Beam  Mode    ：光束模式                SBW       ： 带宽 
Slit Height       ：狭缝高度 
Zero            ：驱动波长到零级光谱。用此进行附件调整。 
注意：波长驱动到零级前，应挡住样品室出口两个窗口，防止检测器受损。 
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单击 Cary窗口转换到 Cary设置页： 

 
                            Cary      仪器参数设置 
 
Beam  Mode          ：  光束模式栏 
Signal  Beam          ：  单光束 
Double  Beam         ：  双光束 
Normal               ：  正常模式。靠近仪器前面板为样品，后为参比。 
Reverse               ：  反转模式。靠近仪器前面板为参比，后为样品。 
Instrument  Parameters  ：  仪器参数栏   
Y  Mode              ：  Y轴模式。  %T ：透过率 。  %R ： 反射率。 
Energy                ：  能量 
Ave  Time(s)          ：  信号平均时间    单位： 秒 
SBW                 ：  带宽 
Slit Height             ： 狭缝高度 
Wavelenth (nm)         ：  波长设置 
Zero order             ：  零级光谱（为白光，附件调整时用）。 
Apply                ：  确认。当改变参数后按此键确定设置。 
 
关于 UV灯，VIS灯的调整方法参数硬件手册和软件帮助手册有关部分进行。 
 

 

 

 

 

52



 

八．仪器维护 

在 Cary WinUV主窗口中用鼠标双击 Cary  Help图标，进入帮助页面。 

 
 
在Maintenance里面，有仪器清洁、更换保险丝、保存仪器校准用的标准物质、

保护流动比色池的说明。 

在 Replacing lamps里面，有更换钨灯、氘灯的图片和具体操作步骤。 

在 Aligning lamps and mirrors有调整钨灯、氘灯位置的视频和具体步骤。 
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